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1 Introduction to Watcom FORTRAN 77

Welcome to the Watcom FORTRAN 77 11.0 development system.  Version 11.0 of Watcom
FORTRAN 77 is a professional, optimizing, multi-platform FORTRAN 77 compiler with a
comprehensive suite of development tools for developing and debugging both 16-bit and
32-bit applications for DOS, extended DOS, Novell NLMs, 16-bit OS/2 1.x, 32-bit OS/2,
Windows 3.x, Windows 95, Win32s, and Windows NT (Win32).

You should read the entire contents of this booklet, as it contains information on new
programs and modifications that have been made since the previous release.

Special NOTE to users of previous versions!  See the section entitled "Release Notes for
Watcom FORTRAN 77 11.0" on page 53 to determine if you need to recompile your
application.

1.1 What is in version 11.0 of Watcom FORTRAN 77?
Version 11.0 incorporates the features professional developers have been demanding:

Open, Multi-target Integrated Development Environment
The IDE allows you to easily edit, compile, link, debug and build applications for
16-bit systems like DOS, OS/2 1.x, and Windows 3.x and 32-bit systems like
extended DOS, Novell NLMs, OS/2, Windows 3.x (Win32s), Windows 95, and
Windows NT.  Projects can be made up of multiple targets which permit a project to
include EXEs and DLLs.  The IDE produces makefiles for the project which can be
viewed and edited with a text editor.  The IDE is hosted under Windows 3.x,
Windows 95, Windows NT, and 32-bit OS/2.

The Widest Range of Intel x86 Platforms

Host Platforms

• DOS (command line)
• 32-bit OS/2 (IDE and command line)
• Windows 3.x (IDE)
• Windows 95 (IDE and command line)

What is in version 11.0 of Watcom FORTRAN 77? 1



Chapter 1

• Windows NT (IDE and command line)

16-bit Target Platforms

• DOS
• Windows 3.x
• OS/2 1.x

32-bit Target Platforms

• Extended DOS
• Windows 3.x using our 32-bit extender technology
• Win32s
• Windows 95
• Windows NT
• 32-bit OS/2
• Novell NLMs
• AutoCAD ADS

Cross-Platform Development Tools
The core tools in the package permit cross-platform development that allows
developers to exploit the advanced features of today’s popular 32-bit operating
systems, including Windows 95, Windows NT, and OS/2.  Cross-platform support
allows you to develop on a host development environment for execution on a
different target system.

Multi-Platform Debugger
The new debugger advances developer productivity.  New features include
redesigned interface, ability to set breakpoints on nested function calls, improved
C++ and DLL debugging, reverse execution, and configurable interface.  Graphical
versions of the debugger are available under Windows 3.x, Windows 95, Windows
NT, and 32-bit OS/2.  Character versions of the debugger are available under DOS,
Windows 3.x, Windows NT, and 32-bit OS/2.  For VIDEO fans, we have kept the
command line compatibility from the original debugger.

Performance Analysis
The Watcom Execution Sampler and Watcom Execution Profiler are performance
analysis tools that locate heavily used sections of code so that you may focus your
efforts on these areas and improve your application’s performance.

Editor The Watcom Editor is a context sensitive source editor, integrated into the Windows
3.x, Windows 95 and Windows NT version of the IDE.
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Graphical Development Tools
Watcom FORTRAN 77 includes a suite of graphical development tools to aid
development of Windows 3.x, Windows 95 and Windows NT applications.  The
development tools include:

Resource Editors Enable you to create resources for your 16-bit and 32-bit
Windows applications.  For 32-bit OS/2 PM development,
Watcom FORTRAN 77 includes IBM’s resource editors.  These
tools have been seamlessly integrated into the IDE.  The
resource compiler allows you to incorporate these resources
into your application.

Resource Compiler Produces a compiled resource file from a source file.

Zoom Magnifies selected sections of your screen.

Heap Walker Displays memory usage for testing and debugging purposes.

Spy Monitors messages passed between your application and
Windows.

DDESpy Monitors all DDE activity occurring in the system.

Dr. Watcom Enables you to debug your program by examining both the
program and the system after an exception occurs; monitors
native applications running under Windows 3.x, Windows 95 or
Windows NT.

Assembler
An assembler is now included in the package.  It is compatible with a subset of the
Microsoft assembler.

Licensed components of OS/2 2.1 Toolkit
Includes the full OS/2 2.1 Presentation manager and character mode APIs, on-line
help and example programs.

Licensed components of Windows 3.1 Toolkit
Includes the full Windows 3.1 API libraries and on-line help.

Licensed components of Windows NT Toolkit
Includes the full Windows NT API libraries and on-line help.

Licensed components of Novell NLM SDK 4.0
Includes all header and import files needed to create an NLM.
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Royalty-free 32-bit DOS Extender
Watcom FORTRAN 77 includes the DOS/4GW 32-bit DOS extender by Tenberry
Software with royalty-free run-time and virtual memory support up to 32MB.

Support for wide range of DOS Extenders
Watcom FORTRAN 77 allows you to develop and debug applications based on the
following DOS extender technology:  Tenberry Software’s DOS/4G and Phar Lap’s
TNT DOS Extender.  You can also develop applications using FlashTek’s DOS
Extender but, currently, there is no support for debugging these applications.

Sample programs and applications
Watcom FORTRAN 77 includes a large set of sample applications to demonstrate the
new integrated development environment.

1.2 Technical Support and Services
We are committed to ensuring that our products perform as they were designed.  Although a
significant amount of testing has gone into this product, you may encounter errors in the
software or documentation.  Our technical support offers a variety of services to help you
work around any problems you may encounter.  Watcom FORTRAN 77 11.0 includes
60-days of free installation assistance.  Installation assistance will include installing the
product and compiling and running the samples that are included with the product for your
specific environment.  Subsequent to this 60-day period, technical assistance is available
through our fee-based support programs.  Please contact us for more information.

In order to keep informed about product updates and announcements, we suggest that you
send in your registration card.  Product registration cards are included in the package and can
be mailed or faxed to us.

Resources at Your Fingertips

Watcom FORTRAN 77 contains many resources to help you find answers to your questions.
The documentation is the first place to start.  With each release of the product, we update the
manuals to answer the most frequently asked questions.  Most of this information is also
accessible through on-line help.

The "README" file in the main product directory contains up-to-date information that
recently became available.

Answers to frequently asked questions are available on CompuServe, Powersoft’s World
Wide Web server, Powersoft’s FTP site, Powersoft’s bulletin board, or the Powersoft’s
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Faxline fax back system.  These services are available 24 hours a day.  See the Powersoft
Customer Services Reference Guide for more information on Automated Technical Support
(ATS).

Contacting Technical Support

Our technical support is available to help resolve technical defects in the software.  The
following are ways to contact technical support.

Telephone The telephone number for the Technical Support office nearest to you is listed in
the Customer Services Reference Guide.

Fax The telephone number of the facsimile machine for the Technical Support office
nearest to you is listed in the Customer Services Reference Guide.

World Wide Web You can also send bug reports or enhancement requests to Technical
Support using the Powersoft World Wide Web server.  Electronic forms are
available for on-line completion.

FTP You can obtain a copies of the bug report or enhancement request forms from
the Powersoft FTP site.

 
ftp://ftp.powersoft.com/pub/watcom/general/wbugrep.zip
ftp://ftp.powersoft.com/pub/watcom/general/wenhreq.zip

The bug report form (WBUGREP.TXT) is available on Compuserve, the Powersoft BBS, and
Faxline (document #1014).  The enhancement request form (WENHREQ.TXT) is available
on Compuserve, the Powersoft BBS, and Faxline (document #1015).

Information Technical Support Will Need to Help You

Your registration number will be required when you contact Technical Support.

The more information you can provide to your technical support representative, the faster they
can help you solve your problem.  A detailed description of the problem, short sample
program, and a summary of steps to duplicate the problem (including compiler and linker
options) are essential.  Concise problem reports allow technical support to quickly pinpoint
the problem and offer a resolution.  Here is a list of information that will help technical
support solve the problem:
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Contact information
We would like your name, as well as telephone and fax numbers where you can
be reached during the day.

Product information
Please tell us the product name, version number, patch level, and software
registration number.

Hardware configuration
Please tell us what type of processor you are using (e.g., 33MHz 486SX), how
much memory is present, what kind of graphics adapter you are using, and how
much memory it has.

Software configuration
Please tell us what operating system and version you are using.

Output from the TECHINFO utility
Please provide the output from the Techinfo utility.  It lists current patch levels,
environment variable settings, and the contents of your AUTOEXEC.BAT and
CONFIG.SYS files.

Concise problem report with short sample program
Please provide a complete description of the problem and the steps to reproduce
it.  A small, self-contained program example with compile and link options is
ideal.

An electronic form of communication is often preferable for reporting technical problems.  It
provides an easy and efficient way to receive sample code and complete problem details.

Making Fixes Available to Developers: The Patch Utility

We are dedicated to fixing problems in our products.  We developed the patch utility to enable
timely responses to bugs in the software.  Patches are frequently made available and are
designed to address problems with the software.  When you call technical support one of the
first questions asked is your current patch level.

How do I determine the current patch level?
Here are two easy ways for you to determine your current patch level:

1. At the command line, type the command "techinfo".  Among other
information, it displays the patch level of the various components in
the package.
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2. If you are using the command line tools, the FORTRAN 77 compiler
displays a banner at startup that echo the version number with the
patch level.

How can I get the patches?
Patches are made available on CompuServe, our World Wide Web server, our
FTP site, and our bulletin board.  They are available 24 hours a day.  Patches are
also available on the current release CD-ROM.

How do I apply the patches?
Once you have downloaded the patches, issue the pkunzip command to unzip
the patch files.  A "README" file provides information on the patch.

How can I ensure the patch applied correctly?
Running the Techinfo utility indicates the current patch level of the tools.
Ensure that the patch indication for the files is the one you just applied.

1.3 Third-party Support
A large number of third party software packages support the use of the Watcom FORTRAN
77.  We have included a document on the CD-ROM which describes some of these packages.
The information on these software packages was provided by the developers of these
packages.  The document takes the form of a help file, of which versions are provided for
DOS, Windows 3.x, Windows 95, Windows NT, and OS/2.

1.4 Suggested Reading
There are a number of good books and references that can help you answer your questions.
Following is a list of some of the books and documents we feel might be helpful.  This is by
no means an exhaustive list.  Contact your local bookstore for additional information.

DOS Developers

PC Interrupts, Second Edition
Ralf Brown and Jim Kyle; Addison-Wesley Publishing Company, 1994.

Relocatable Object Module Format Specification, V1.1
The Intel OMF specification can be obtained from the Intel ftp site.  Here is the
URL.
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ftp://ftp.intel.com/pub/tis/omf11g.zip

This ZIP file contains a Postscript version of the Intel OMF V1.1 specification.

Extended DOS Developers

Extending DOS—A Programmer’s Guide to Protected-Mode DOS, 2nd Edition
Ray Duncan, et al; Addison-Wesley Publishing Company, 1992.

DOS Protected-Mode Interface (DPMI) Specification
The DPMI 1.0 specification can be obtained from the Intel ftp site.  Here is the
URL.

 
ftp://ftp.intel.com/pub/IAL/software specs/dpmiv1.zip

This ZIP file contains a Postscript version of the DPMI 1.0 specification.

Windows 3.x Developers

Microsoft Windows Programmer’s Reference
Microsoft Corporation; Microsoft Press, 1990.

Programming Windows 3.1, Third Edition
Charles Petzold; Microsoft Press, 1992.

Windows Programming Primer Plus
Jim Conger; Waite Group Press, 1992.

Windows NT Developers

Advanced Windows NT
Jeffrey Richter; Microsoft Press.  1994.

Inside Windows NT
Helen Custer; Microsoft Press.  1993.

Microsoft Win32 Programmer’s Reference, Volume One
Microsoft Corporation; Microsoft Press, 1993.
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OS/2 Developers

The Design of OS/2
H.M.  Deitel and M.S.  Kogan; Addison-Wesley Publishing Company, 1992.

OS/2 Warp Unleashed, Deluxe Edition
David Moskowitz and David Kerr, et al; Sams Publishing, 1995.

OS/2 Technical Library.
To order the Technical Library, call one of the following numbers.

 
In Canada: 1-800-465-1234
In the United States: 1-800-426-7282 (OS/2 2.x)

1-800-879-2755 (OS/2 Warp)

You can also order copies of these books from an IBM authorized dealer or IBM
representative.
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2 Installation

The package contains the following components:

• Watcom FORTRAN 77 CD-ROM
• This manual
• Registration Card
• Envelope containing important information
• Customer Services Reference Guide

2.1 Send in Your Registration Card
You should fill out and mail your registration card as soon as possible to ensure you are
informed of future upgrades and other special offers to registered users.  Your registration
number is printed on the registration card.  Retain the other portion of the registration card
for your records.  Your registration number is printed on it.  You will need this number
when you contact Technical Support.

2.2 Hardware and Software Requirements
Watcom FORTRAN 77 requires the following minimum configuration:

• IBM PC compatible

• An 80386 or higher processor

• 8 MB of memory

• 162 MB of disk space.

Note that the disk space requirement varies with the disk cluster size.  The larger the
cluster size, the greater the disk requirement.  If your hard disk has 4K clusters (129MB
to 256MB), a complete installation will require 162 MB megabytes of disk space.  If
your hard disk has 16K clusters (513MB to 1GB), a complete installation will require
181 MB megabytes.  A selective install will require considerably less space.
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• A CD-ROM disk drive

In addition to the above requirements, you need one of the following operating systems:

• DOS version 5.0 or higher
• Microsoft Windows version 3.1 running in enhanced mode
• Microsoft Windows 95
• Microsoft Windows NT version 3.1 or higher
• IBM OS/2 2.1 or higher

You must install the software from a CD-ROM drive.  Unlike earlier releases, it is now no
longer possible to copy the installation files to diskettes and install the software from your
diskette drive.

2.3 The README File
Before you install Watcom FORTRAN 77, you should read the contents of the "README"
file which is stored in the root directory of the CD-ROM.  It contains valuable, up-to-date
information concerning this product.

2.4 Installing Watcom FORTRAN 77
The installation program in this version has been completely redesigned with several new
"smart" features.  If you have installed a previous version of Watcom FORTRAN 77 then you
should install Watcom FORTRAN 77 11.0 into the same path (except for the reason described
in the following paragraph).  It will examine a previous installation to determine what features
were previously installed.  It will use this information to establish default settings for the
installation that you are about to attempt.  Of course, you can add or remove features as you
progress through the installation steps.

If you are installing only one of the Watcom C/C++ or Watcom FORTRAN 77 products and
you have an older version of the other product, we do NOT recommend that you install the
new product into the same directory as the old product.  The Watcom C/C++ and Watcom
FORTRAN 77 products are compatible at the same version number.  However, the Watcom
C/C++ and Watcom FORTRAN 77 products are usually NOT compatible across different
version numbers (e.g., version 9.5 of Watcom FORTRAN 77 is not compatible with version
10.5 of Watcom C/C++ and vice versa).  If this is the case, care must be exercised when
switching between use of the two products.  Environment variables such as PATH and
WATCOM must be modified and/or corrected.  System files such as CONFIG.SYS and
SYSTEM.INI must be modified and/or corrected.

12 Installing Watcom FORTRAN 77
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If you are installing both Watcom C/C++ 11.0 and Watcom FORTRAN 77 11.0, we
recommend that you install both products under the same directory.  This will eliminate
duplication of files and, as a result, reduce the total required disk space.  The two products
share the use of certain environment variables which point to the installation directory.  If
separate installation directories are used, problems will arise.

When you install Watcom C/C++ and Watcom FORTRAN 77 in the same directory, you
should not deselect any options when running the second installation; otherwise the second
product’s install may remove files that were installed (and are required) by the first product’s
install.  This isn’t an issue if you only have one of Watcom C/C++ or Watcom FORTRAN 77.
The problem is that Watcom C/C++ and Watcom FORTRAN 77 don’t know about the
installation options you have selected for each other’s product.

If you wish to create a backup of your previous version, please do so before installing
Watcom FORTRAN 77 11.0.

If you decide to install Watcom FORTRAN 77 11.0 into a different directory than the
previously installed version, you will have to manually edit system files (e.g., CONFIG.SYS,
AUTOEXEC.BAT, SYSTEM.INI) after the installation process is complete to remove the old
version from various environment variables (e.g., PATH, DEVICE=).  This is necessary since
the path to the new version will appear after the path to the old version.  To avoid this extra
work, we recommend installing the new version into the same path as the old version.

As an example, here are a few of the environment variables and "RUN" directives that are
modified/added to the OS/2 CONFIG.SYS file.  You should make sure that all references to
the older version of the software are removed.

Example:
LIBPATH=...;D:\WATCOM\BINP\DLL;...
SET PATH=...;D:\WATCOM\BINP;D:\WATCOM\BINW;...
SET HELP=...;D:\WATCOM\BINP\HELP;...
SET BOOKSHELF=...;D:\WATCOM\BINP\HELP;...
SET INCLUDE=...;D:\WATCOM\H\OS2;D:\WATCOM\H;
SET IPFC=D:\WATCOM\TOOLKT2X\IPFC
SET WATCOM=D:\WATCOM
SET EDPATH=D:\WATCOM\EDDAT
RUN=D:\WATCOM\BINP\BATSERV.EXE
RUN=D:\WATCOM\BINP\NMPBIND.EXE

You may wish to run Watcom FORTRAN 77 under more than one operating system on the
same personal computer.  For every operating system that you use, simply start up the
operating system and run the corresponding install procedure.

If you run the Windows 3.x installation procedure, you do not need to run the DOS
installation procedure also.

Installing Watcom FORTRAN 77 13
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If you plan to use Win-OS/2 as a development platform under OS/2, you must run the
Windows 3.1 install program (selecting Windows 3.1 host support).

Place the CD-ROM disk in your CD-ROM drive.  Select one of the following procedures
depending on the host operating system that you are currently running.  Below, substitute the
CD-ROM drive specification for "x:".

DOS Enter the following command:
 
x:\setup

Windows 3.x Start Windows 3.x and choose Run from the File menu of the Program
Manager.  Enter the following command:

 
x:\setup

Windows 95 Choose Run from the Start menu and enter the following command:
 
x:\setup

Windows NT Log on to an account that is a member of the "Administrator" group so
that you have sufficient rights to modify the system environment.
Choose Run from the File menu of the Program Manager.  Enter the
following command:

 
x:\setup

OS/2 Start an OS/2 session and enter the following command:
 
x:\install

2.5 Incremental Installation
You may wish to install Watcom FORTRAN 77, and subsequently install features that you
omitted in the first install.  You can also remove features that you no longer wish to have
installed.  You can achieve this as follows:

1. Start the installation program.
2. Select any new features that you wish to install.
3. Deselect any features that you wish to remove.
4. Re-run the installation program for each host operating system that you use.
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2.6 System Configuration File Modifications
The install program makes changes to your operating system startup files to allow Watcom
FORTRAN 77 to run.  We strongly recommend that you allow the install program to modify
your system configuration files for you, but you may do it by hand.  The changes required
may be found in any of the following files which have been placed in the root of the
installation directory:

CONFIG.NEW Changes required for CONFIG.SYS (DOS, Windows, Windows
95, OS/2)

AUTOEXEC.NEW Changes required for AUTOEXEC.BAT (DOS, Windows, Windows
95, OS/2)

CHANGES.ENV Changes required for the Windows NT environment

2.7 Installation Notes for Windows 3.x
1. When you use the Integrated Development Environment under Windows 3.x, it is

important that the IDE’s batch server program be able to run in the background.
Therefore, make sure that the "Exclusive in Foreground" checkbox is NOT checked
in the "Scheduling" options of "386 Enhanced" in the "Control Panel".

2. When you use the Integrated Development Environment under Windows 3.x, the
line

 
OverlappedIO=ON

in your "SYSTEM.INI" file can cause problems.  This controls (disables) the
queuing of DiskIO and makes some changes between DOS box timings to allow
some processes to finish.

3. When you use the Integrated Development Environment under Windows 3.x, it is
important that the line

 
NoEMMDriver=ON

not appear in your "SYSTEM.INI" file.  It will prevent a link from succeeding in
the IDE..

4. When you use the Integrated Development Environment under Windows 3.x on the
NEC PC-9800 series, it is important that the line

Installation Notes for Windows 3.x 15
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InDOSPolling=TRUE

not appear in your "SYSTEM.INI" file.  It will prevent a make from succeeding in
the IDE.

5. Central Point Software’s anti-virus programs (VDEFEND, VSAFE, VWATCH)
conflict with the Integrated Development Environment under Windows 3.x.

6. The Program Information File "BATCHBOX.PIF" is used by the Integrated
Development Environment (IDE) to start up a background batch server for
compiling, linking, etc.  The PIF references "COMMAND.COM".  If you are using
a substitute for "COMMAND.COM" such as "4DOS.COM" then you must modify
the PIF accordingly using a PIF editor.

2.8 Installation Notes for OS/2
1. The Integrated Development Environment (IDE) uses the IBM OS/2 Enhanced

System Editor (EPM) for editing text files.  You must ensure that EPM is installed
in your OS/2 system if you are planning to use the IDE.  You can selectively install
the Enhanced Editor by running the OS/2 Setup and Installation program (Selective
Install) and choosing "Enhanced Editor" from the "Tools and Games" detail page.

2. The Integrated Development Environment (IDE) requires that the BATSERV.EXE
program be started during OS/2 initialization.  If you plan to use the IDE, do not
remove the "RUN=" line for this file from your CONFIG.SYS file.

3. On some systems with limited memory that use the UNDELETE feature of OS/2,
compile times may be slow because OS/2 is saving copies of compiler temporary
files.  You may start the BATSERV process using the OS/2 STARTUP.CMD file
with DELDIR turned off as illustrated below.

 
SET OLD DEL DIR=%DELDIR%
SET DELDIR=
DETACH C:\WATCOM\BINP\BATSERV.EXE
SET DELDIR=%OLD DEL DIR%
SET OLD DEL DIR=

4. If you plan to use the Named Pipe Remote Debugging support of the Watcom
Debugger then the NMPSERV.EXE.  program must be started during OS/2
initialization.  If you plan to use this feature, do not remove the "RUN=" line for
this file from your CONFIG.SYS file.
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2.9 Installation Notes for Win32s
There is a directory called WIN32S in the SDK directory of the CD-ROM.  It contains the
entire Win32s directory structure.  The Watcom FORTRAN 77 install program will install
Win32s onto your computer system, but it will not install the debug version of Win32s.  If you
want to use the debug version of Win32s, type the commands:

 
X:
cd \sdk\win32s
install D:

where "X" is the drive letter of your CD-ROM drive, and "D" is the drive you want to install
Win32s on.  Once you have done this, you can use SWITCH.BAT in the WIN32S\BIN
directory to switch between the debug and non-debug versions of Win32s.

As an alternative to installing Win32s using the Watcom FORTRAN 77 install program, you
can run X:\SDK\WIN32S\DISKS\DISK1\SETUP.EXE.

Installation Notes for Win32s 17
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3 Hands-on Introduction to Watcom
FORTRAN 77

Let’s get started and introduce some of the new tools that are in version 11.  The purpose of
this chapter is to briefly test out the new graphical tools in version 11 using an existing
application.

In this tutorial, we will take an existing set of FORTRAN 77 source files, create a project in
our integrated development environment, and perform the following tasks:

• Add multiple targets
• Make a target
• Make all targets
• Execute the program
• Debug the program
• Correct errors
• Sample and profile the executable
• Save the project
• Terminate the session

3.1 Outline
Watcom’s Integrated Development Environment (IDE) manages the files and tools that a
programmer uses when developing a project.  This includes all the source files, include files,
libraries, compiler(s), linkers, preprocessors, etc.  that one uses.

The IDE has a graphical interface that makes it easy to visualize the make-up of a project.  A
single IDE session shows a project.  If the project consists of a number of components, such
as two executables and one library, these are each shown as target windows in the project
window.  Each target window shows the files that are needed to construct the target and is
associated via its filename extension with a rule that describes the construction mechanism.
For example, a filename with the extension ".EXE" may be associated with the rule for
constructing 32-bit Windows executables, or a filename with the extension ".LIB" may be
associated with the rule for constructing static libraries.  Different projects can refer to the
same target.  If they do, the target is shared and can be manipulated via either project, with
changes made through one affecting the other.
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The IDE itself is a collection of programs that manages the various files and tools used to
create the target libraries and executables.  It creates makefile(s) from the information in the
target descriptions and invokes Watcom Make to construct the targets themselves.  A
configuration file contains built-in knowledge of the Watcom compilers, editors, Profiler, and
Browser, as well as all their switches.

3.2 The Watcom FORTRAN 77 Tutorial
This tutorial walks you through the creation and execution of a FORTRAN 77 program under
Windows.  This will give you an understanding of the basic concepts of the IDE and its
components, and it will detail the steps involved in project development.  The result of this
tutorial is a three dimensional drawing of a kitchen which you can manipulate using either the
menus or the icons on the toolbar.  You can rotate and resize the drawing, as well as adjust the
lighting and contrast.

To begin, start the IDE.  This is done by double-clicking on the "IDE" icon in the Watcom
FORTRAN 77 window.

A status field at the bottom of the IDE window indicates the function of the icon on the
toolbar over which your mouse cursor is currently positioned.  If the status area does not show
you the function of the icons as you move the mouse cursor over them, check that no item in
the menu bar is highlighted (if one is highlighted, press the Alt key).

Figure 1. The initial IDE screen
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Defining a Project

In this tutorial, you will be creating a new project called KITCHEN.  Here are the steps
required to accomplish this task.

1. Define a new project by pulling down the File menu and selecting the New
Project...  item.  You can also define a new project by clicking on the "Create a
new project" icon on the toolbar.

2. A choice of different sample project directories is available.  Assuming that you
installed the Watcom FORTRAN 77 software in the \WATCOM directory, you will
find the sample project directories in the following directory:

 
\WATCOM\SAMPLES\IDE\FORTRAN

For purposes of this tutorial, we recommend that you select one of the following
project directories:

WIN for an example of 16-bit Windows 3.x application development when
using Windows 3.x under DOS as a host development system,

WIN386 for an example of 32-bit Windows 3.x application development when
using Windows 3.x under DOS as a host development system,

WIN32 for an example of 32-bit Win32 application development when using
Windows NT or Windows 95 as a host development system, and

OS2 for an example of 32-bit OS/2 application development when using
32-bit OS/2 as a host development system.

Thus the target that we refer to below should be one of WIN, WIN386,
WIN32, or OS2 depending on your selection.  The tutorial uses the WIN32
example for illustrative purposes.  You will find some minor variations from your
selected target environment.

When asked for a project name, you can do one of two things:

1. enter the following pathname:
 
d:[path]\SAMPLES\IDE\FORTRAN\target\KITCHEN

where d:[path] is the drive and path where you installed the Watcom
software, or
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2. use the file browser to select the following directory:
 
d:[path]\SAMPLES\IDE\FORTRAN\target

and specify the filename KITCHEN.

Figure 2. Creating a new project

Press the Enter key or click on OK (OPEN).

The project description will be stored in this file and the IDE will set the current
working directory to the specified path during your session.

3. You will be prompted for a target name.  Since we will be attaching pre-defined
targets, just click the Browse button when prompted for the target name.  Select the
"draw" target file (it will be one of DRAW16.TGT, DRAW.TGT, DRAW32.TGT,
DRAWOS2.TGT depending on your selection of target).
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Figure 3. Attaching existing targets

Press the Enter key or click on OK (OPEN).

4. You can ignore the settings displayed for Target Environment and Image Type
since the target definition already exists (we created it for you).  The settings are
important when you a defining a new target (i.e., one that was not predefined).

Figure 4. Selecting a target type

Press the Enter key or click on OK.
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A target window is created in the project window for the "draw" target.  This window contains
all of the files associated with the target.  You can click on any of the "Folder" icons to hide or
un-hide all files with a particular extension.  For example, you may wish to un-hide all the
files with a .BMP extension by clicking on the folder icon associated with bitmap files.

Adding Multiple Targets

Watcom’s IDE allows you to have multiple targets in any particular project.  Note that targets
can be used by multiple projects.  To add a new target to the project, do the following.

1. Pull down the Targets menu and select the New Target...  item.

2. Enter BUTTON.TGT as the target name for the new target to be added to the
project.  Do not forget to include the .TGT extension.  It is required when selecting
a pre-existing target.

3. You can ignore the settings displayed for Target Environment and Image Type
since the target definition already exists (we created it for you).  The settings are
important when you a defining a new target (i.e., one that was not predefined).

4. Press the Enter key or click on OK.

A target window is created in the project window for the button target.

Making a Target

Watcom’s IDE will automatically generate the sequence of steps required to build or "make"
each of the targets in a project.  Note that the targets in a project can be made individually or
collectively.  To make the button.lib target, do the following.

1. Click on the window of the target you wish to make.  In this case, click on the
button.lib target window.

2. Pull down the Targets menu and select the Make item (you can also do this by
clicking on the "Make the current target" icon on the toolbar, or by right-clicking
on the target and selecting the Make item from the pop-up menu).

The IDE will now construct a makefile based on its knowledge of the target and construction
rules, and then invoke the make utility to create the target, in this case button.lib.  The
output of this procedure is displayed in the Log window.
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Making All Targets

Click the "Make all targets in the project" icon on the toolbar to make all of the targets in the
current project.  If one target depends on another target, the latter target will be made first.  In
this tutorial BUTTON.LIB will be made first (there will be nothing to do since it was made
previously) and then DRAW???.EXE, since BUTTON.LIB is in the list of files associated
with DRAW???.EXE.  In each case, the IDE constructs makefiles based on its knowledge of
the target and construction rules.  The output of this procedure is displayed in the Log
window.

Figure 5. Making one or more targets
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Executing the Program

The project should have built without errors, so now you are ready to execute the program you
have developed.

Click on the DRAW???.EXE target window and simply click on the "Run the current target"
icon on the toolbar.  You can also do this by selecting Run from the Targets menu, or
right-clicking anywhere on the target window outside of the inner frame and selecting Run
from the pop-up menu (right-clicking is context sensitive and the pop-up menu that results
will vary depending on the area of the window in which you right-click).

Figure 6. The kitchen demo

The demo you have created is a simple three dimensional drawing of a kitchen.  By using
either the icons on the toolbar or the menus you can rotate the picture left, right, up, and
down, make the picture brighter or dimmer, move the picture closer or farther away, and
increase or decrease the amount of contrast (this latter feature is found in the "Lighting"
menu).  Choose Exit from the File menu to exit the demo program when you are finished.
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Smart Editing

The IDE recognizes the type of file you wish to edit, and invokes the appropriate editor for the
task.  To edit a file, you either double-click on it or select it and click the "Edit" icon on the
toolbar.  Files with a .C, .CPP, .H, .HPP, .FOR, .ASM or .RC extension are edited
with a text editor; files with a .BMP, .ICO, or .CUR extension are edited with the Image
Editor; files with a .DLG or .RES extension are edited with the Resource Editor.

Figure 7. The Watcom Editor for Windows

Now we will edit one of the source files and introduce an error into the application.

1. Double-click on the "draw" source file (i.e., DRAW???.FOR) to load the source
file into the editor.

2. Search for the line containing the text:
 
c$ifdef undefined

For Windows users, "Find" is in the "Edit" menu.  If you are building a WIN386
application, search for the second line containing this text (located in subroutine
memclear).
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3. Now, to introduce an error into the application, add the line
 
c$define undefined

just before the line containing c$ifdef.

4. Save your changes by clicking on the "Write the current file to disk" icon or select
Save from the File menu.

5. Return to the IDE (by clicking on it if it is visible on your screen, or by using
Alt-Tab), re-make your project, and run it.  A fault occurs in your application, so
the next step is to track down the problem using the Watcom Debugger.

Debugging the Program

To debug a program it must first be compiled to include debugging information.  The IDE
maintains two sets of switches for each target in a project.  These are known as the
Development Switches and the Release Switches.

1. Right click on DRAW???.FOR and select Source options from the pop-up menu.
Select Fortran Compiler Switches from the sub-menu.

By default, your target is placed in development mode with the debugging switches
for the compiler and linker set to include debugging information.  You can either
set the switches in each category manually or you can copy the default Release
switches using the CopyRel button.  This method of setting switches is especially
convenient since you can specify everything from diagnostic, optimization, and
code generation switches to special linker switches all without having to memorize
a cryptic switch name — you simply click next to the switches you wish to use for
a particular item.

2. Scroll through the categories using the >> button until you get to:
 
4. Debugging Switches

We can see that full debugging information was used in the compile, so just click
on Cancel to exit this screen.
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Figure 8. Setting compiler switches

3. To invoke the debugger, pull down the Targets menu and choose the Debug item or
select the "Debug the current target" icon from the toolbar.

The Watcom Debugger is designed to be as convenient and intuitive as possible, while at the
same time providing a comprehensive and flexible environment for serious debugging.  You
can configure your environment to display exactly the information you require to be most
productive.  Among the windows available are source and assembly, modules, functions,
calls, threads, images, watches, locals, globals, file variables, registers, 80x87 FPU, stack, I/O
ports, memory display, and a log window.  You can step through your source using the keys
or icons on the toolbar.  Execute one line at a time by stepping over calls or stepping into
calls, or execute until the current function returns.  Right-mouse button functionality gives
context-sensitive pop-up menus.
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Figure 9. The Watcom Debugger

We know that a fault has occurred in DRAW???.EXE, so we will run the application and
examine the state of the program when the fault occurs.

1. Click on the "go!" icon on the toolbar to begin execution of the program.  The
exception occurs and the source window shows the line

 
arr( cnt ) = ch

in the subroutine memclear as the last line executed before the exception.
Examining the Locals window you will see that the array location or address,
locale, is 0.  This means that the array arr was mapped to location 0.  For the
32-bit Windows example, we also needed to use the "array" pragma to force a far
pointer reference to cause the exception.
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2. We can now move up the call stack by clicking on the "Move up the call stack"
icon on the toolbar (red up arrow) to follow the program’s execution.  On the
previous executable line of code, we see memclear is called from the main
program with three arguments.

 
call memclear( 0, loc(Draw area), isizeof(RECTL) )

We see that memclear is called with 0 as the first argument and
loc(Draw area) as the second argument which is backwards to the way it
should be.  An artificial error was introduced for the purposes of this tutorial.

3. By removing the line
 
c$define undefined

we can undo this error.  Exit the debugger.

4. Double-click on DRAW???.FOR to load the source file into the editor.

5. Go to the line in question using "find" or "search" and delete the line.  Save your
changes by clicking on the "Write the current file to disk" icon or selecting Save
from the File menu.

6. Return to the IDE (by clicking on it if it is visible on your screen, or by using
Alt-Tab) and re-make your project.

7. Run your project to see the kitchen demo.

Correcting an Error

We are now going to introduce an error into the source code to illustrate another feature of the
IDE.

1. Double-click on DRAW???.FOR to load the source file into the editor.

2. Search for the line containing the text:
 
c$ifdef undefined

For Windows users, "Find" is in the "Edit" menu.

3. Now, to introduce a syntax error into the application, add the line
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hThree d + 0

just before the line containing c$ifdef.

4. Save your changes by clicking on the "Write the current file to disk" icon or select
Save from the File menu.

5. Return to the IDE (by clicking on it if it is visible on your screen, or by using
Alt-Tab).

6. Click the "Make all targets in the project" icon to re-make the project.

An error is encountered during the make and error message(s) appear in the log window.
Additional information on the error is available by selecting the error, pulling down the Log
menu and selecting the Help on Message item.

1. Double-click on the error message
 
drawwin.for(83): *ERR* ST-17 column 9, undecodeable statement or
misspelled word HTHREE D

The offending source file ( DRAW???.FOR) is loaded into the Editor and the
cursor is positioned at the line which caused the error.

2. Delete the line to correct the error.

3. Save your changes.

4. Return to the IDE and re-make the project.

Editing a Bitmap

You can edit bitmaps, icons, or cursors associated with your project using Watcom’s Image
Editor.  Double-click on a file with a .BMP, .ICO, or .CUR extension and the file is loaded
into the Image Editor.  The editor has many features to design your images, including resizing,
rotation, shifting, and a utility to take a "snapshot" of another image and import it.
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Figure 10. The Watcom Image Editor

Suppose you wanted to change the color of the right-arrow icon in your application.

1. If the "Folder" icon next to .BMP is closed, click on it to restore all the files with a
.BMP extension to the file list.

2. Scroll the window until the file RIGHT.BMP is visible.

3. Double-click on RIGHT.BMP in the DRAW???.EXE target window.

4. Select the "Paint Can" icon from the Tool Palette.

5. Select a color from the Color Palette.
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6. Click on the arrow.

7. Save your changes using the "Save" icon on the toolbar and exit the Image Editor.

8. Click the "Make all targets in the project" icon to rebuild the project with the
change incorporated.

Editing Menus

Next, you will add source files to the list of items that make up DRAW???.EXE.

1. Pull down the Sources menu and select the New Source...  item.

Note: You can do this either by choosing from the menu bar or by
positioning the mouse over the file list area and clicking the right
mouse button.  The IDE displays a pop-up menu from which you can
choose the desired action.

2. Enter the filename DRAW.RES (or DRAWOS2.RES for OS/2).  For OS/2, click OK
when you have entered the source file name.  For all other systems, click on Add
when you have entered the source file name and then click on Close.  Now we will
remove the .RC file from the project so that our changes to the .RES file will not
be overwritten.  When an .RC file is present, the .RES file is generated from the
.RC file.

3. Right click on DRAW.RC (or DRAWOS2.RC for OS/2), then select Remove Source
from the pop-up menu.

4. Double-click on DRAW.RES (or DRAWOS2.RES).  The Resource Editor is
invoked, displaying all the available resources (in this case, icons, bitmaps, and
menus).
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Figure 11. The Watcom Resource Editor

5. Click on "Menu Resources".

6. Double-click on "DrawMenu" in the right-hand box.  This will bring up the Menu
Editor.  The Menu Editor displays the menus defined for the resource DrawMenu.
You can specify pop-up menus, menu items and sub-items, text, separators,
attributes, break styles, and memory flags.
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Figure 12. The Watcom Menu Editor

7. Click on MENUITEM "&Dimmer" in the item list window.

8. In the "Item Text" window change the item to &Darker and then click on the
"Change" button.

9. Select Update from the File menu or click on the "Update the file with this menu"
icon.

10. Exit the Menu Editor.
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11. Now, select Save from the File menu or click on the "Save this file" icon and exit
the Resource Editor.

12. Click the "Make all targets in the project" icon to re-make the project.

Sampling and Profiling an Executable

Together, the Watcom Execution Sampler and the Watcom Execution Profiler allow you to
pinpoint the areas of your code that are the most heavily used, indicating possible candidates
for performance improvements.

1. Click on the DRAW???.EXE target.

2. Select the Sample item from the Targets menu item, or click on the "Run and
sample the current target" icon from the toolbar.  The Watcom Execution Sampler
is invoked and your application begins to execute.

3. Try rotating and resizing the image a few times.  The sampler takes a "snapshot" of
the code that is being executed at regular intervals.  Exit the application.  A samples
file with extension .SMP is created in the current directory.  This file is input for
the profiler.

4. You are now ready to profile the executable.  Do this by selecting Profile from the
Targets menu, or by clicking on the "Profile the current target" icon on the toolbar.
The profiler scans the .SMP file and reports the activity in the various modules of
the application.  The percentage of time spent in the modules is indicated as an
absolute percentage (percent of total samples) and as a relative percentage (percent
of samples in the .EXE image).

5. Double-click on the module or routine names to step down to the exact source
being executed when a sample was taken.  For more details, you can adjust the
sampling rate of the Sampler to get a better picture of your code.  To do this, exit
the Profiler, pull down the Targets menu, and select Target options, then Sample
Switches...  from the pop-up menus.  Specify a sampling rate such as 2 (for 2
milliseconds), click on OK, then run the Sampler and Profiler again.
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Figure 13. The Watcom Execution Profiler

Saving the Project and Terminating the Session

You can now exit the IDE session by selecting Exit from the File menu.  If you have not
already saved your project, you will be prompted to do so.  Choose "Yes" and the session
ends.

3.3 Tutorial Review
In this tutorial, you created a project called KITCHEN.WPJ, which was composed of two
targets: DRAW???.EXE and BUTTON.LIB.  You compiled and linked it into an executable
program using the WMAKE utility, the Watcom FORTRAN 77 compiler, and the Watcom
Linker.  You executed it both directly and under the control of the Watcom Debugger..  You
browsed the source, and made changes using the text and resource editors.  Finally, you
sampled and profiled the application.

When you saved the project, you created the following permanent files:

• KITCHEN.WPJ — describes the screen layout and refers to the target files called
DRAW???.TGT and BUTTON.TGT.
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• DRAW???.TGT — describes the target executable DRAW???.EXE and all switches
required to link it.  It also describes the .FOR files and switches required to compile
them.

• BUTTON.TGT — describes the target library and all switches required to create it.  It
also describes the .FOR file and the switches used to build the library.
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4 Documentation

The following manuals comprise the Watcom FORTRAN 77 documentation set.  Printed
copies of this documentation can be ordered from Watcom.  When you install the software,
the Watcom FORTRAN 77 documentation set is provided as on-line help files.  Subsequent
sections describe how to access this on-line help.

The following describes the titles in the Watcom FORTRAN 77 documentation set.

Watcom FORTRAN 77 User’s Guide
This manual describes how to use Watcom FORTRAN 77.  It contains an
introduction to the compiler and a tutorial section.  It also describes compiler
options, include file processing, libraries, memory models, calling conventions,
pragmas, in-line assembly, and environment variables.

Watcom FORTRAN 77 Tools User’s Guide
This manual describes the command line oriented tools including the compile
and link utility, library manager, object file disassembler, far call optimization
tool, assembler, patch utility, strip utility, make utility, and touch utility.

Watcom Graphical Tools User’s Guide
This manual describes Watcom’s Windows and OS/2 graphical tools including
the Integrated Development Environment, Browser, Dr.  Watcom, Spy, DDE
Spy, Image Editor, Resource Editor, Sampler/Profiler, Resource Compiler, Heap
Walker, Zoom, and Editor.

Watcom FORTRAN 77 Programmer’s Guide
This manual includes 5 major sections each of which describes operating system
specific development issues.  The operating systems covered include extended
DOS, OS/2, Windows 3.x, Windows NT/Win32s, 32-bit Windows 3.x (using
Watcom’s Supervisor technology), AutoCAD ADS and Novell NLMs.  Topics
include creating a sample program, operating system specific error messages,
and debugging techniques.

Watcom FORTRAN 77 Language Reference
This manual describes the ANSI FORTRAN 77 programming language and
extensions which are supported by Watcom FORTRAN 77.
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Watcom FORTRAN 77 Graphics Library Reference
This manual describes the graphics libraries supported by Watcom FORTRAN
77.  The graphics functions are used to display graphical images such as lines
and circles upon the screen.  Functions are also provided for displaying text.

Watcom Debugger User’s Guide
This manual describes the Watcom Debugger and discusses advanced debugging
techniques.

Watcom Linker User’s Guide
This manual describes how to use the Watcom Linker to generate executables
for target systems such as extended DOS, Windows 3.x, Windows 95, Windows
NT, OS/2, and Novell NLMs.

4.1 Accessing On-line Documentation
The following sections describe how to access the on-line help that is available for DOS,
Windows 3.x, Windows 95, Windows NT and OS/2.

On-line Documentation under DOS

The Watcom Help program, WHELP, may be used under DOS to access on-line
documentation.  The Watcom Help command line syntax is:

 
WHELP help file [topic name]

Notes:

1. If help_file is specified without an extension then ".IHP" is assumed.

2. The topic_name parameter is optional.

3. If topic_name is not specified, the default topic is "Table of Contents".

4. If topic_name contains spaces then it must be enclosed in quotes.

The following help files are available:
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CLIB Watcom C Library Reference

FMIX Watcom FORTRAN 77 Master Index

FPGUIDE Watcom FORTRAN 77 Programmer’s Guide

FTOOLS Watcom FORTRAN 77 Tools User’s Guide

FUGUIDE Watcom FORTRAN 77 User’s Guide (excludes Diagnostic Messages appendix
which is available as a separate help file)

F77LR Watcom FORTRAN 77 Language Reference

F77GRAPH Watcom FORTRAN 77 Graphics Library Reference

ISVFOR Watcom FORTRAN 77 11.0 Add-In Tools Guide

LGUIDE Watcom Linker User’s Guide

F_README Watcom FORTRAN 77 Getting Started manual

RESCOMP Documentation for the Watcom Resource Compiler for Windows (excerpt from
the Watcom Graphical Tools User’s Guide)

WD Watcom Debugger User’s Guide

WPROF Documentation for the Watcom Execution Sampler and Watcom Execution
Profiler (excerpt from the Watcom Graphical Tools User’s Guide)

WFCERRS Documentation for the Watcom F77 Diagnostic Messages (excerpt from the
Watcom FORTRAN 77 User’s Guide).

On-line Documentation under Windows 3.x, 95 and NT

On-line documentation is presented in the form of Windows Help files (".HLP" files).  When
the software is installed under Windows 3.x, Windows 95 or Windows NT, a number of
program groups are created.  You can access the on-line document by opening a program
group and double-clicking on a help icon.
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Watcom FORTRAN 77 Group  

Getting Started Watcom FORTRAN 77 Getting Started

Watcom FORTRAN 77 Tools Help Group  

Accelerator Editor Help Documentation for the Accelerator Editor (excerpt from the
Watcom Graphical Tools User’s Guide)

C Library Reference Watcom C Library Reference

DDE Spy Help Documentation for the DDE Spy utility (excerpt from the Watcom
Graphical Tools User’s Guide)

Debugger Help Watcom Debugger User’s Guide

Dialog Editor Help Documentation for the Dialogue Editor (excerpt from the Watcom
Graphical Tools User’s Guide)

Dr. Watcom Help Documentation for Dr.  Watcom (excerpt from the Watcom
Graphical Tools User’s Guide)

Editor Help Documentation for the Watcom Editor (excerpt from the Watcom
Graphical Tools User’s Guide)

FORTRAN 77 Error Messages Documentation for the Watcom F77 Diagnostic Messages
(excerpt from the Watcom FORTRAN 77 User’s Guide)

FORTRAN 77 Master Index The master index for all of the Watcom FORTRAN 77 on-line
help

Heap Walker Help Documentation for the Heap Walker utility (excerpt from the
Watcom Graphical Tools User’s Guide)

IDE Help Documentation for the Interactive Development Environment
(excerpt from the Watcom Graphical Tools User’s Guide)

Image Editor Help Documentation for the Image Editor (excerpt from the Watcom
Graphical Tools User’s Guide)

Linker Guide Watcom Linker User’s Guide

Menu Editor Help Documentation for the Menu Editor (excerpt from the Watcom
Graphical Tools User’s Guide)
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Profiler Help Documentation for the Watcom Execution Sampler and Watcom
Execution Profiler (excerpt from the Watcom Graphical Tools
User’s Guide)

Programmer’s Guide Watcom FORTRAN 77 Programmer’s Guide

Resource Compiler Help Documentation for the Resource Compiler (excerpt from the
Watcom Graphical Tools User’s Guide)

Resource Editor Help Documentation for the Resource Editor (excerpt from the Watcom
Graphical Tools User’s Guide)

Spy Help Documentation for the Spy utility (excerpt from the Watcom
Graphical Tools User’s Guide)

String Editor Help Documentation for the String Editor (excerpt from the Watcom
Graphical Tools User’s Guide)

Tools Guide Watcom FORTRAN 77 Tools User’s Guide

User’s Guide Watcom FORTRAN 77 User’s Guide

Zoom Help Documentation for the Zoom utility (excerpt from the Watcom
Graphical Tools User’s Guide)

The second set of help files, listed below, forms part of the Microsoft Windows SDK.

Watcom FORTRAN 77 Additional Help Group  

Add-In Tools Guide A guide to third-party software tools/libraries

Hotspot Editor Help

MCI Command Strings

MFC 4.1 Library Help

MFC 4.1 Sample Program Help

MFC 4.1 Technical Notes

MFC 2.52b Library Help

Accessing On-line Documentation 45



Chapter 4

MFC 2.52b Sample Program Help

MFC 2.52b Technical Notes

Multimedia Reference

Pen API Reference

Win32 API Help

Windows API Reference

On-line Documentation under OS/2

On-line documentation is presented in the form of OS/2 Information files (".INF" files).
When the software is installed under OS/2, the Watcom FORTRAN 77 folder is created.  You
can access the on-line document by opening the Watcom FORTRAN 77 folder and
double-clicking on a help icon.

C Library Reference Watcom C Library Reference

CP Reference OS/2 Control Program Reference

Debugger Help Watcom Debugger User’s Guide

FORTRAN 77 Error Messages Documentation for the Watcom F77 Diagnostic Messages
(excerpt from the Watcom FORTRAN 77 User’s Guide)

FORTRAN 77 Master Index The master index for all of the Watcom FORTRAN 77 on-line
help

Getting Started Watcom FORTRAN 77 Getting Started

IDE Help Documentation for the Interactive Development Environment
(excerpt from the Watcom Graphical Tools User’s Guide)

IPFC Reference OS/2 IPF Compiler Reference

Linker Guide Watcom Linker User’s Guide

PM Reference OS/2 Presentation Manager Reference
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Profiler Help Documentation for the Watcom Execution Sampler and Watcom
Execution Profiler (excerpt from the Watcom Graphical Tools
User’s Guide)

Programmer’s Guide Watcom FORTRAN 77 Programmer’s Guide

REXX Reference OS/2 REXX Reference

Tools Guide Watcom FORTRAN 77 Tools User’s Guide

Tools Reference OS/2 Toolkit Reference

User’s Guide Watcom FORTRAN 77 User’s Guide
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5 Additional Redistribution Rights

Please read carefully the information in the following sections if you plan to distribute your
application to others.

5.1 Redistributable Components
Subject to the terms and conditions of the Powersoft Language Products Software License
Agreement, in addition to any Redistribution Rights granted therein, you are hereby granted a
non-exclusive, royalty-free right to reproduce and distribute the Components specified below
provided that (a) it is distributed as part of and only with your software product; (b) you not
suppress, alter or remove proprietary rights notices contained therein; and (c) you indemnify,
hold harmless and defend Powersoft and its suppliers from and against any claims or lawsuits,
including attorney’s fees, that arise or result from the use or distribution of your software
product.

The Tenberry Software (formerly Rational Systems, Inc.) and Watcom Components are:

• DOS4GW.EXE Copyright  1990-1994 Tenberry Software, Inc.

• RMINFO.EXE Copyright  1987-1993 Tenberry Software, Inc.

• PMINFO.EXE Copyright  1987-1993 Tenberry Software, Inc.

• PRIVATXM.EXE Copyright  1991 Tenberry Software, Inc.

• DOS4GW.DOC Copyright  1991-1995 Tenberry Software, Inc.

• WEMU387.386 Copyright  1991-2000 Sybase, Inc.

The Microsoft Components from the Microsoft Windows SDK version 3.1, all Copyright 
1992 Microsoft Corporation, are:

• COMMDLG.DLL
• COMMDLG.DAN
• COMMDLG.DUT
• COMMDLG.FIN

Redistributable Components 49



Chapter 5

• COMMDLG.FRN
• COMMDLG.GER
• COMMDLG.ITN
• COMMDLG.NOR
• COMMDLG.POR
• COMMDLG.SPA
• COMMDLG.SWE
• DDEML.DLL
• LZEXPAND.DLL
• OLECLI.DLL
• OLESVR.DLL
• PENWIN.DLL
• SHELL.DLL
• STRESS.DLL
• TOOLHELP.DLL
• VTD.386
• VER.DLL
• DIB.DRV
• EXPAND.EXE
• MARKMIDI.EXE
• REGLOAD.EXE
• WINHELP.EXE
• WINHELP.HLP

5.2 OS/2 Toolkit
You may distribute components from the OS/2 Toolkit included in the package which are
header files and include files and you may modify and distribute components from the OS/2
Toolkit included in the package which are sample programs provided that such header files,
include files and sample programs are distributed only for the purposes of developing, using,
marketing and distributing application programs written to the OS/2 application programming
interface.  Further, with respect to sample programs, each copy of any portion thereof or any
derivative work which is so distributed must include a copyright notice as follows:

 
(c) Copyright (your company name) (year). All Rights Reserved.
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5.3 Microsoft Win32s
You may sublicense Microsoft Win32s (hereinafter referred to as the "MS CODE") but only
in object-code form and solely in conjunction with your application developed using Watcom
FORTRAN 77 and only if:  your application and/or any documentation bears copyright
notices sufficient to protect Microsoft’s copyright in the MS CODE; the MS CODE is not
incorporated into any product which would enable such MS CODE to be used in conjunction
with, or to develop application programs for non-Microsoft operating systems (This restriction
does not apply to MS CODE which runs or can be run on non-Microsoft operating systems
without modification), you indemnify Powersoft and Microsoft from and against any claim
arising from the distribution of your application or otherwise arising hereunder excluding any
claims that the MS CODE infringes a U.S.  copyright held by a third party; your application
and the MS CODE are sublicensed pursuant to a written license agreement between you and
your customer which conforms substantially to the terms and conditions of the Powersoft
Language Products Software License Agreement (printed elsewhere in this document)
together with the additional terms and conditions set forth herein.  Without limiting the
generality of the foregoing, said license agreement shall indicate that you are the licensor and
shall contain provisions limiting Powersoft’s and Microsoft’s liability to the same extent as
they are limited in the Powersoft Language Products Software License Agreement and these
additional terms and conditions.
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6 Release Notes for Watcom FORTRAN 77
11.0

There are a number of enhancements and changes in this new version of Watcom FORTRAN
77.  The following sections outline most of the major changes.  You should consult the User’s
Guide for full details on these and other changes made to the compiler and related tools.  You
should check the next section to determine if you need to recompile your application.

6.1 Changes in 11.0 that may Require Recompilation
Do not attempt to mix object code generated by earlier versions of the compilers with object
code generated by this release or with the libraries provided in this release.

clock() The clock function accuracy has changed from 100 ticks per second to 1000
ticks per second (i.e., CLOCKS_PER_SEC has changed).  Source code that uses
the clock function and CLOCKS_PER_SEC in its calculations must be
recompiled before linking the application with new libraries.

6.2 Major Differences from Version 10.6
The following sections summarize the major differences from the previous release of Watcom
FORTRAN 77.

• Some of the Win32 and 32-bit OS/2 versions of our tools are now available in DLL
form.

 
EXE      DLL        Description
------   -------    -----------------------
wlink    wlink      Watcom Linker
wlib     wlibd      Watcom Library Manager

This provides better performance when using the Integrated Development Environment
or Watcom Make.  See the description of the !loaddll preprocessing directive in
Watcom Make for more information.
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Changes to the Code Generator for 11.0

• A new optimization, "branch prediction", has been added.  This optimization is enabled
by the "OBP" or "OX" compiler options.  The code generator tries to increase the
density of cache use by predicting branches based upon heuristics (this optimization is
especially important for Intel’s Pentium Pro).

• We have added Multi-media Extensions (MMX) support to the in-line assembler.

Changes to the Compiler Tools for 11.0

• The Watcom Linker supports incremental linking.

• The Watcom Linker can now process COFF and ELF format object files, as well as
OMF et al.  The Watcom Linker can now read both AR-format (Microsoft compatible)
libraries and old-style OMF libraries.

• Support for creating 16-bit DOS overlaid executables has been removed from the
linker.

• The Watcom Library Manager (WLIB) can now process COFF and ELF format object
files, as well as OMF et al.  The Watcom Library Manager can now read/write both
AR-format (Microsoft compatible) libraries and old-style OMF libraries.  The default
output format is AR-format and this can be changed by switches.  The Watcom Library
Manager can output various format import libraries.

• We have added Multi-media Extensions (MMX) support to the Watcom Assembler
(WASM).

• A new version of the Watcom Disassembler (WDIS) is included.  It can process ELF,
COFF or OMF object files and ELF, COFF or PE format (Win32) executables.

The old disassembler (WDISASM) has been retired and is not included in the package.

• We have added new tool front-ends that emulate Microsoft tools.  These are:

• rc

These programs take the usual Microsoft arguments and translate them, where possible,
into equivalent Watcom arguments and spawn the equivalent Watcom tools.

54 Major Differences from Version 10.6



Release Notes for Watcom FORTRAN 77 11.0

• Watcom Make now processes Microsoft format makefiles when the "ms" option is
used.

Changes to the C/C++ Libraries for 11.0

• We have added multi-byte and wide character (including UNICODE) support to the
libraries.

• We have added Multi-media Extensions (MMX) support to the libraries.

• The clock function accuracy has changed from 100 ticks per second to 1000 ticks per
second (i.e., CLOCKS_PER_SEC has changed).

Changes to the DOS Graphics Library for 11.0

• The graphics library now performs the VESA test before testing for vendor specific
graphics cards.  This fix is intended to broaden the number of graphics cards that are
supported.

Changes in Microsoft Win32 SDK Support for 11.0

• The Win32 SDK is included for Windows 95 and Windows NT platforms.

6.3 Changes in 10.6 that may Require Recompilation
_diskfree_t The struct members of the _diskfree_t structure has been changed from

UNSIGNED SHORTs to UNSIGNED INTs.  This is to deal with possible HPFS
partitions whose size will overflow a short, as well as Microsoft compatibility.

clock() The clock function accuracy has changed from 100 ticks per second to 1000
ticks per second (i.e., CLOCKS_PER_SEC has changed).  Source code that uses
the clock function and CLOCKS_PER_SEC in its calculations must be
recompiled before linking the application with new libraries.
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6.4 Major Differences from Version 10.5
The following sections summarize the major differences from the previous release of Watcom
FORTRAN 77.

Windows 95 Help File Format

We have included Windows 95 format help files.

Changes to the C Library

The following new functions were added to the library.

_getw read int from stream file

_putw write int to stream file

The clock function accuracy has changed from 100 ticks per second to 1000 ticks per second
(i.e., CLOCKS_PER_SEC has changed).

Changes to the Image Editor

• Support has been added for > 16 colours for bitmaps.

• Support has been added for 16 X 16 icons.

• Support has been added for 48 X 48 icons.

Changes to the Dialog Editor

• Support has been added for Windows 95 controls.

• Support has been added for adding new control styles to existing controls.

• Support has been added for new dialog styles.

• Support has been added for allowing help IDs to be specified in dialog and control
statements.
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• Support has been added for generating new resource statements in .RC files.

Changes to the Resource Editor

• Support has been added for new Windows 95 resource types.

• Support has been added for generating new resource statements in .RC files.

Changes to the Resource Compiler

• Support has been added for extended styles for dialogs.

• Support has been added for the RCINCLUDE keyword.

6.5 Major Differences from Version 9.5
• The functionality of Watcom FORTRAN 7716 and Watcom FORTRAN 7732 is
included in a single package.

• OS/2 3.0 Warp is supported.

• Windows NT 3.5 is supported.

• Windows 95 (Chicago) is supported.

• An Integrated Development Environment for Windows 3.x, Windows 95, Windows NT
and OS/2 PM is included.

• New, redesigned debugger with GUI interfaces for Windows 3.x, Windows 95,
Windows NT and OS/2 PM is included.

• TCP/IP remote debug servers for OS/2 and Windows NT are included.

• The optimizer has been enhanced.

• New, redesigned user interface for the Profiler.

• Windows resource editing tools are included:
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Dialog Editor
Bitmap Editor
Resource Editor
Menu Editor
String Editor
Accelerator Editor

• Windows development tools are included:

Dr. WATCOM (a post mortem debug utility)
Spy (Windows message spy program)
DDESpy
Heap Walker
Zoom

• On-line documentation is included.

• Creation of FlashTek DOS extender applications is supported.

• Compiler executables have been created that run under all supported operating systems.
They are located in the BINW directory.

Items No Longer Supported

• Debugging of Ergo OS/386 DOS extender applications

• DESQView remote debugging

Changes that may Require Recompilation

FORTRAN applications should not require recompilation, but you should recompile your
application if you want to take full advantage new features in the debugger.

6.6 Major Differences from Version 9.0
The following lists some of the new features/differences between version 9.5 and 9.0.

1. The "/resource" option has been added and allows run-time messages to be placed
in the executable file as resource information instead of being linked with the
application.  The resource file containing these messages is called "wf77.res" and is
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locating in the root of the directory in which you installed the software.  The strip
utility (WSTRIP) can be used to place the resource information in the executable
file.  Special libraries for processing resource information will be required when
you link your application.  These libraries are called "wresf.lib" (for 32-bit register
calling convention), "wresfs.lib" (for 32-bit stack calling convention), "wresm.lib"
(for 16-bit medium memory model), and "wresl.lib" (for 16-bit large and huge
memory models) and are located in the "lib386" and "lib286" directories of the
directory in which you installed the software.

2. The "/5" option has been added and causes the compiler to generate code that is
optimized for the Pentium.  This is the default.  The "/fp5" option has been added
and causes the compiler to generate floating-point code that is optimized for the
Pentium.  This is not the default.  The default floating-point option is "/fp3".

3. The "/3" option has been added and causes the compiler to generate code optimized
for a 80386 processor.  The "/4" option has been added and causes the compiler to
generate code optimized for a 80486 processor.  The "/5" option has been added
and causes the compiler to generate code that is optimized for the Pentium.  In
addition, the "/fp5" option has been added and causes the compiler to generate
floating-point code that is optimized for the Pentium.

4. The "/descriptor" option has been added which specifies that string descriptors are
to be passed for character arguments.  You can specify the "/nodescriptor" option if
you do not want string descriptors to be passed for character arguments.  Instead,
the pointer to the actual character data and the length will be passed as two
arguments.  The arguments for the length will be passed as additional arguments
following the normal argument list.  For character functions, the pointer to the data
and the length of the character function will be passed as the first two arguments.

5. The "oi" option has been added.  This option causes code for statement functions to
be generated in-line.

6. The floating-point model used when generating in-line 80x87 instructions has
changed.  If you wish to call subprograms compiled with version 9.0 you must
specify the "/fpr" option.

7. Support for records in text files separated by only a line feed character has been
added.  Previously, records in text files had to be separated by a carriage return/line
feed sequence.

8. The "/debug" option has been divided into two separate options.  The "/bounds"
option generates array and character subscript checking code.  The "/trace" option
generates code that allows a run-time traceback to be generated when a error is
issued.

9. The "/quiet" option has been added to suppress banner/summary information.  The
"terminal" option only affects the display of diagnostic messages (extensions,
warnings and errors).  For example, compiling with the "/quiet" option will only
display diagnostic messages (if any).

10. The "/cc" option has been added.  It specifies that unit 6 is a carriage control device
and that output to this unit will be assumed to contain carriage control characters.
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Note that a blank carriage controle character will automatically be generated for
list-directed output.

11. The "/automatic" option causes all local variables (including arrays) to be allocated
on the stack.  Care should be taken when using this option since the stack
requirements of your application may increase dramatically.

12. The "/wild" option has been added.  It suppresses the compile-time checking that
normally causes an error to be issued when an attempt is made to transfer control
into a block structure from outside the block structure and vice versa.  This option
is only to be used when compiling existing code that contains GOTO statements of
this type; it does not encourage this style of programming.

13. National language support has been added.  The "/japanese" option causes the
compiler to process Japanese double-byte characters in variable names and
character data.  Similarly, the "/chinese" option will process Traditional Chinese
characters and the "/korean" will process Korean characters.

14. The "/ob" option has been added.  This allows the code generator to use register
ESP as a base register to reference local variables and subprogram arguments.
Note that when this option is specified, the compiler will abort when there is not
enough memory to optimize the subprogram.  By default, the code generator uses
more memory-efficient algorithms when a low-on-memory condition is detected.

15. The GROWHANDLES() function has be added.  This function increases the
number of files that can be opened by a program to the specified amount.  The
value returned is the new maximum.  This may be less than the requested amount
because of operating system limitations.

16. The IARGC() and IGETARG() functions have been added.  IARGC is an integer
function that returns the argument count.  IGETARG is an integer function that
takes two arguments.  The first argument is of type INTEGER and is the index of
the argument to be returned.  The second argument is of type CHARACTER and is
used to return the argument.  The value returned by the function is the length of the
argument.

17. The SHARE= specifier has been added to the OPEN statement.  It allows the
program to specify how other processes can access a file that is opened by the
original process.  Possible values for the SHARE= specifier are as follows.

 
DENYRW - deny read and write access
DENYWR - deny write access
DENYRD - deny read access
DENYNO - allow read and write access
COMPAT - compatibility mode
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